# Table of Contents

The AllSky Camera

1. Camera Focusing ........................................................................................................2

1.1 Camera Focusing ......................................................................................................2

2 Hauppauge Hardware .................................................................................................5

2.1 Hauppauge Video Capture Card ................................................................................5

2.2 Hauppauge USB-Live 2 ..........................................................................................6

3 WSentinel Software ....................................................................................................7

3.1 User Settings ...........................................................................................................7

3.1.1 Options ................................................................................................................9

3.1.2 Display ................................................................................................................9

3.1.3 Current Display settings ......................................................................................11

3.1.4 Trigger ................................................................................................................11

3.1.5 Current Trigger settings ......................................................................................12

3.1.6 Making an Image Mask .......................................................................................12

3.2 Playback ..................................................................................................................13

3.3 Event Playback ........................................................................................................14

3.4 Time Synchronization ..............................................................................................17

4 Troubleshooting .........................................................................................................18
# List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Current Display settings</td>
<td>11</td>
</tr>
<tr>
<td>3.2 Current Trigger settings</td>
<td>12</td>
</tr>
</tbody>
</table>
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>1</td>
</tr>
<tr>
<td>1.2</td>
<td>2</td>
</tr>
<tr>
<td>1.3</td>
<td>4</td>
</tr>
<tr>
<td>2.1</td>
<td>5</td>
</tr>
<tr>
<td>2.1</td>
<td>6</td>
</tr>
<tr>
<td>3.1</td>
<td>8</td>
</tr>
<tr>
<td>3.2</td>
<td>8</td>
</tr>
<tr>
<td>3.3</td>
<td></td>
</tr>
</tbody>
</table>
1 The AllSky Camera

The main components of the system include a Sony black and white CCD video camera, camera lens, 12 Volt DC power adapter, resistive heaters, thermostat, DC fan, a video capture card, and a weatherproof optical dome and housing. The housing consists of PVC pipe and flanges. It is a requirement for the AllSky Camera system to be operational 24 hours a day, 365 days a year; therefore, it must be able to work in all weather conditions. The heaters, thermostat, and fan are to maintain a reasonable (100°F), thermal environment for the camera system to operate within. This thermal environment is mainly to help ensure that the dome remains condensation free no matter what the moisture level is outside the housing.

Figures 1.1 and 1.2 show “cut-away” views of the camera and the environmental electronics. There are no user serviceable parts inside. There are two versions of the AllSky Camera Systems that have been distributed, they are slightly different, but both are functionally the same.

Figure 1.1: AllSky Camera Version 1
The only possible need for opening the unit is if focusing the camera becomes necessary. The camera is shipped “pre-focused” but may require some adjusting due to movement in shipping.

1.1 Camera Focusing

At night, when the camera’s auto-iris opens fully, focus is most critical. What may seem to be a good focus on a daytime scene can become blurry when the iris is fully opened. So, proper focusing must be done with a dark scene. A scheme has been devised that allows that to be done in daytime hours.

For recipients of cameras with Fujinon lenses, if setting the focus under nighttime conditions is difficult, which is often the case; the following method will permit focusing it during the day.
Build a tube 22 or 33 inches in length by taping together, using duct tape, cardboard cylinders from paper towel rolls. Since the cardboard is not quite totally opaque, cover the cylinder with a layer of duct tape. An easy way to do that is to lay the tube down on a flat surface and apply the tape lengthwise. Four strips of tape will cover the entire tube.

With the tube so constructed, cut a disk of cardboard (not corrugated) to cover the end of the tube and tape it into place, keeping the center of the disk clear of tape. Then, near the center of the disk, pierce a small hole using a small sewing needle. Before placing the tube over the lens, adjust the zoom so that the horizon circle is the desired diameter with the scene in reasonably good focus. Then, place the tube over the top of the lens and secure it to the lens with masking tape. This will create a pinpoint of light in an otherwise dark scene.

Adjust the ambient light so that the pinpoint of light as seen by the camera is dim. The reason for that is to avoid blooming. If the light level on a pixel on the camera’s CCD chip is high enough to exceed the pixel’s electric charge retention capacity, the excess charge will flow into adjacent pixels, making them appear bright also. That condition is called blooming, and if occurring, will be detrimental to achieving sharp focus.

Adjust the focus to achieve the smallest pinpoint spot on the image, and if necessary, reduce the light level coming through the pinhole to keep the spot dim. Once satisfied with the focus, remove the tube, being careful to not touch the zoom or focus levers in the process.

The camera mounting is the responsibility of the host user, since we have no control over the cameras physical mounting location. At SSL, the cameras were mounted on all-weather simulated wood. This allowed for a flat surface to mount the camera by the flanges using \( \frac{1}{2} \)” lag screws. Attaching the cameras to the “platform” made it easy to install the camera at almost any location utilizing a couple of bricks. This is a simple method that is cost effective and doesn’t require drilling to the actual roof surface and can be relocated easily. It uses the all-weather simulated wood, so sun, rain, snow, rotting wood, etc. is not an issue and cost is minimal.

AC Power and the BNC cable are needed for the camera to operate and to bring the signal down to the computer that will be running the WSentinel capture software.
2 Hauppauge USB-Live 2

1. Install the software per the directions provide from Hauppauge for this device.

2. Connect the BNC cable from the AllSky Camera to the BNC video adapter, (BNC male RCA); connect to the Yellow (Video) plug on adapter.

3. Connect the USB into any available USB slot.
   
   • Note: Hauppauge does not recommend connecting via a USB Hub.
WSentinel Software

Double click on the “WSentinel” and it will auto-install. The program will create a folder and install itself to “C:\Program Files\Sandia National Laboratories\WSentinel”. Launch the software by clicking the “Start” button, then “All Programs”, select “WSentinel”. Start the program to verify that both the hardware and software are working correctly. A dialog window will appear showing real-time video feed from the camera. Verify that you are seeing the current video image. Below the image box on the left is a real-time clock showing the current date and time (UTC). Verify that this is correct and the time is advancing. Below the image to the right is a number that shows how many pixels are above threshold. If the image is stationary, this number should be close to zero. However, if the image changes, this number becomes large or increases accordingly. The button to the extreme left of the image is labeled “Hide RT” (Hide Real-time). If you press this button, the real-time video display will stop and the button will change to “Show RT”. If you press the button again, the real-time video will resume.

IMPORTANT: Screen savers should not be used with WSentinel. If a screen saver runs while WSentinel is running, the Real Time video display becomes disabled and cannot be enabled without restarting WSentinel.
3.1 User Settings

- **File**
  - **New Archive Directory:** This brings up a dialog, which lets you select the directory that will contain all of the event data. This can be a directory on an internal or external hard drive. If you do not select a directory, the program will attempt to place all of the event data in a directory called “WSentinel” in your “My Documents” folder. Four files are created for each event, a .txt, .csv, .jpg, and an .mp4 file.

  - **Open Event:** This will allow you to playback any event in the events” folder. You select the event based on the timestamp of the event. Date and time are embedded in file the name.

  - **Save Image:** This will allow you to make a jpg image of what is seen on the view screen. You can name the image for easy identification and it’s stored in the events folder.

  - **Save Move:** In the Options/Display folder, if the Enable Now selector is checked, you can make a movie of what you are seeing on the viewer. To make an mpeg movie of a selected event, invoke the “Save Movie...” command from the “File” menu. This makes an MPEG1 file.

  - **Read Mask File:** This will allow you to read in the mask file that you have modified for your particular area.

  - **Show Mask:** This will show you a kind of profile image. The areas that should be ignored will be bright and all other areas will be dark.

  ![Figure 3.1: Image mask negative (not to scale)](image-url)
- **Overlay Mask:** This will show where the image has been masked. It will not show any of the image where the mask is to ignore. All that is visible, is where if an event occurs in that area, will be triggered on.

![Figure 3.2: Mask overlay on image (not to scale)](image)

- **Save Settings:** To save the current configuration (e.g., trigger enable/disable times, threshold values, etc.), click on the “Save Configuration” command. The same configuration will then be used the next time WSentinel is launched.

- **Options**

  - **Video**
    - **Video Decoder:** This is where you can select the type of Video Decoder for the events. The Video Decoder will automatically select the Signal and Lines, based on which Video Standard is selected.

      The default Video Standard is NTSC M, which has Signal: 1 and Lines: 525.

    - **Video Proc Amp:** This is where you can set the Brightness, Contrast, Hue, and Saturation of the captured events. Saturation is set by default to “0”, to eliminate any color artifacts from using a black and white camera.

  - **Display**
    - **Time Base:** This button will allow you to set your time base to “Local Time”, which is the time in your time zone area, or “UTC” time, which is the Coordinated Universal Time for your area. In UTC time, remember that there could be an offset of time relative to where you are and GMT.
Example:
3PM MDT (Local) in New Mexico is 9PM in UTC (daylight saving time)
3PM MST (Local) in New Mexico is 10PM in UTC (standard time)

New Mexico is 6 hours ahead of local time in UTC time during daylight savings time and 7 hours ahead in Standard Time.

**NOTE:** This does not set the time stamp of the event for to your local time if an event occurs. All events are time stamped in UTC time. This only allows for ease of setting “enable” and “disable” times for the time that you wish to capture events.

**· Disable:** This is where you would select the time that you want the camera to stop capturing events. Typically like 6 AM, 06:00:00 (HH:MM:SS). You can leave the camera on during the daytime to try and capture daytime fireballs, but you will get many false triggers like birds, insects, clouds, airplanes, etc.

**· Enable:** This is where you would select the time that you want the camera to start capturing events. This is dependent on what time the sun sets in your area. Typically like 7 PM (winter) or 9 PM (summer), 21:00:00, (HH:MM:SS).

**NOTE:** Time for enable and disable are based on a 24 hours clock, (1-23 hours).

**· Max Events Per Hour:** This is where you can set the maximum number of events you wish to record per hour. Typically, about 12 to 15 events under normal circumstances, and a much higher number during a known meteor shower event like the Perseids.

**· Playback Slowdown:** This will allow you to see the playback of recorded events in slow motion.

**· Pseudo Color:** If this box is checked, then playback will be shown using a pseudo color designed to allow you to better resolve brightness gradations. However, note that pseudo color is never applied to the real-time video image.

**· Days to Keep Events:** This sets the number of days of events that are kept on the local/external hard drive, selectable from 1-99 days. This prevents the hard drive from filling up due to it being
days of events captured by WSentinel. This should be set to 30 days.

- **Prefer Composites:** If checked, then playback will be shown (in general) as a single composite image instead of as a movie.

- **Show Tracking Box:** If checked, this imposes a box around the event that is being tracked. This allows for small, quick events easier to spot.

- **Minimal Archive:** This will save the least amount of data per event to minimize the size of the archive.

- **Enable Now:** By checking this box, data/events are being recorded and overrides the enable/disable time set above. This is used to verify that the camera and software are working/triggering immediately. Data/events will continue to be captured until the box is un-checked.

### Current SSL1 Display settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Checked?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Base</td>
<td>Local</td>
<td></td>
</tr>
<tr>
<td>Disable</td>
<td>05:00:00</td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>21:00:00</td>
<td></td>
</tr>
<tr>
<td>Max Events per Hour</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Playback Slowdown</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Days to Keep Events</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>Pseudo Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prefer Composites</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Tracking Box</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Minimal Archive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Now</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3.1: Current SSL1 Display settings

**Note:** Setting the “Time Base” to local helps keep your mind straight as to what time to start and stop capturing events.

“Max Events per Hour” is set so that false triggers don’t get out of hand. “Days to Keep Events” is at two weeks. This should be enough to still go back and look at events, because they are being saved at the SSL server and it won’t fill your hard disk.

- **Trigger**
· **Threshold:** This is the minimum frame-to-frame difference in pixel value that will result in a pixel being counted toward triggering. This threshold applies to all areas of the image that are not masked out by a mask image (see ‘Making an Image Mask’).

· **Trigger Gap:** The current frame is compared to a previous frame, some number of frames back. The larger the trigger gap, the slower the change that can be detected.

· **Trigger Count Begin—End, Trigger Sum Begin—End:** An event is initiated when the number of pixels above threshold is greater-than or equal to “Trigger Sum Begin” for at least “Trigger Count Begin” frames in a row. However, an event is also terminated if it lasts longer than “Max Event Time”.

· **Max Event (sec):** This is the maximum number of seconds that an event will be recorded. Typically, most events do not last longer than a few seconds, but the larger fireballs and sometimes falling space debris can last much longer. If an event lasts longer than the maximum event time, a new event will be recorded. It is possible that some valuable data could be lost in between end event and start of new event. This is user defined based on how long you wish each recorded event to last.

· **Current SSL1Trigger settings:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>60</td>
</tr>
<tr>
<td>Trigger Gap</td>
<td>10</td>
</tr>
<tr>
<td>Trigger Count Begin</td>
<td>2</td>
</tr>
<tr>
<td>Trigger Count End</td>
<td>2</td>
</tr>
<tr>
<td>Trigger Sum Begin</td>
<td>12</td>
</tr>
<tr>
<td>Trigger Sum End</td>
<td>5</td>
</tr>
<tr>
<td>Max Event (sec)</td>
<td>15</td>
</tr>
</tbody>
</table>

Table 3.2: Current SSL1 Trigger settings

**Note:** Each node area will be unique in what its settings will be, but these settings are a good place to start. We really have not had to change these settings except for “Threshold”, which started at 35 and was adjusted up to 60. If you are in a remote, dark location with little or no city light pollution, or aircraft, etc., then 35-40 will be a good setting to start with.
3.1.1 Making an Image Mask

Masking allows you to specify areas of the image that you want to ignore for purposes of triggering an event, such as flashing lights that would continuously trigger the system. To make a mask, do the following:

1. With an image from your Sentinel camera displayed in your Sentinel window, save a jpeg image using the “Save Image...” item in the “File” menu.
2. Open this image using the Paint program and paint all the areas that you wish to ignore bright red. A value of 255 for red should work.
3. Save the modified image, named mask.jpg
4. Select the Read Mask File...” item in the “File” menu and select the modified image.

Example:
3.2 Playback

The bottom row of controls below the image allows you to select and play snippets from any video that has been collected. Select the start time and the duration of the event of interest and then press the “Play” button. If video from the selected time is available, it will be played with the video time displayed below the image. If you press the “Save” button, then the video for the specified time and duration will be saved as an event. The event is added to the event list and the associated video is preserved. Video that is not part of an event is eventually erased based on available hard drive space as the disk fills to make room for new video.

3.3 Event Playback

Playback of events is performed using buttons on the top row located below the image. The “First” button plays the first event in the event list. You can also press the “Home” key on the keyboard. The “Last” button plays the last event in the event list. You can also press the “End” key on the keyboard. Other events in the event list are reached using the “Previous” and “Next” buttons. You can also press the left arrow and right arrow keys on the keyboard. The “Delete” button deletes the current event, removing it from the event list. You can also press the “Delete” key on the keyboard. The “Replay” button replays the current event as a movie. The “Composite” button replays the current event as a single composite image. While a video is playing, the ” Pause” button is enabled. Pressing this button freezes the video and the button changes to “Resume”. Pressing the button again resumes the video. To go to a specific event, select “Open Event...” from the “File” menu. You will select the event file (a text file) in the “Events” folder, in the directory where all Sentinel data is placed.

4 Upload Script Installation

- See SSL Events Upload.pdf
4.1 Time Synchronization

Highly recommend the use of Dimension 4 Time Synchronization Software (http://thinkman.com/dimension4/download.htm) under the Freeware version (please donate) unless you have a GPS timestamp capability for your PC clock. Please follow the following setup if you have neither of these.

The time tagging of events files requires that the local clock be appropriately synchronized. The following instructions will set up the node computer to automatically synchronize to the network time protocol (NTP) server. By default, Windows XP (Pre-Service Pack 2) updates the system clock once every seven days. Because the computer could drift several seconds or even minutes in this time frame, we recommend changing the update time interval to a minimum of once an hour, preferably once every 15 minutes. **Be very careful when following these instructions as you can mess up your computer configuration with the regedit program.**

1. Click on Start, open Run... command.
2. Type “regedit” and hit enter.
3. Click on HKEY_LOCAL_MACHINE.
4. Click on SYSTEM.
5. Click on Current Control Set.
6. Click on Services.
7. Click on W32Time.
8. Click on Time Providers.
9. Click on Ntp Client.
10. Click on Special Poll Interval and change the Base from Hexadecimal to Decimal.
11. Enter the value that you want in seconds for updating. Typical for our application is every hour (3600 sec) or every 15 minutes (900 sec), in the Value data: field.
12. Close the Registry Edit.

More information about configuring Windows time services can be found on the Microsoft support pages at http://support.microsoft.com/kb/816042
5 Troubleshooting

- **Black Image:** This occurs when the lens cap is on or if the BNC cable is connected to the wrong input port.

  - **Solution:** Remove the lens cap, and/or connect the BNC cable to the input port that is located furthest left side of the PCI card, (looking at the back of the computer).

- **WSentinel Is Always Recording Everything:** This occurs when the “Enable Now” box is checked in the Display Folder under the Options Tab. This could also happen if the Enable/Disable times are set incorrectly.

  - **Solution:** Uncheck the “Enable Now” box, or verify that the Enable/Disable times are set correctly. See Enable/Disable instructions in the Options Tab under Display.

- **Image On Screen Doesn’t Change:** This usually occurs after a Last or Previous Playback.

  - **Solution:** Click on the “Show RT” tab which is Show Real-time image of what the camera is currently imaging.

- **Condensation On Inside of Dome:** Sometimes, despite our best efforts, condensation can still form on the inside of the dome. This can cause serious or fatal harm to the camera and the internal electronics in the camera housing.

  - **Solution:** Unscrew the dome housing cover and wrap some Teflon (plumbers tape) around the threads of the camera housing to help seal gaps that are allowing outside cool air to enter the dome housing and condensate on the inside of the dome.

- **WSentinel Is Triggering On Everything:** When there are an excessive amount of events being captured with little to no activity happening in the capture box or visible in the playback.

  - **Solution:** Lower the Threshold” number in the Options Display Tab by about 5 counts or more and observe if this is still happening, continue to make adjustments till excessive triggering stops.
• **False Triggering:** There are a large number of events that can be captured that are “False Positive” events. These are captured by WSentinel because they are indeed events, just not the desired events that we are trying to capture. Some of these events can’t be controlled, such as birds or bats, airplanes, bugs, flying debris caused by wind/storms, street lights, etc.

  – **Solution:** While you can’t control most of these false triggering events, there are some ways to minimize them. You can make or modify a mask to tell WSentinel NOT to trigger on certain areas such as lights, street lights. You can raise the “Threshold Level” for the triggering so that small/short events don’t trigger like bugs and birds.

• **WSentinel Not Running After Restart:** Sometimes, when you come in the next morning, WSentinel is not running. This can occur after power is interrupted to the computer. This can also occur after a software update and the computer restarts for updates to take effect.

  – **Solution:** WSentinel needs to be added or pinned to the Start Menu. This can also be accomplished by adding it to the scheduler that starts programs by default or after power cycle.

  **Note:** A UPS-Surge Suppressor is recommended.